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Technology Licenses

The hardware and/or software 
described in this document are 
furnished under a license and may be 
used or copied only in accordance 
with the terms of such license.


Restricted Rights Legend

If software is for use in the 
performance of a U.S. Government 
prime contract or subcontract, 
Software is delivered and licensed as 
“Commercial computer software” as 
defined in DFAR 252.227-7014 (June 
1995), or as a “commercial item” as 
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defined in FAR 52.227-19 (June 1987) 
or any equivalent agency regulation or 
contract clause. Use, duplication or 
disclosure of Software is subject to 
Keysight Technologies’ standard 
commercial license terms, and 
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of the U.S. Government will receive no 
greater than Restricted Rights as 
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Warranty

THE MATERIAL CONTAINED IN THIS 
DOCUMENT IS PROVIDED “AS IS,” AND IS 
SUBJECT TO BEING CHANGED, WITHOUT 
NOTICE, IN FUTURE EDITIONS. FURTHER, 
TO THE MAXIMUM EXTENT PERMITTED 
BY APPLICABLE LAW, KEYSIGHT 
DISCLAIMS ALL WARRANTIES, EITHER 
EXPRESS OR IMPLIED WITH REGARD TO 
THIS MANUAL AND ANY INFORMATION 
CONTAINED HEREIN, INCLUDING BUT 
NOT LIMITED TO THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE. 
KEYSIGHT SHALL NOT BE LIABLE FOR 
ERRORS OR FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES IN 
CONNECTION WITH THE FURNISHING, 
USE, OR PERFORMANCE OF THIS 
DOCUMENT OR ANY INFORMATION 
CONTAINED HEREIN. SHOULD KEYSIGHT 
AND THE USER HAVE A SEPARATE 
WRITTEN AGREEMENT WITH WARRANTY 
TERMS COVERING THE MATERIAL IN THIS 
DOCUMENT THAT CONFLICT WITH THESE 
TERMS, THE WARRANTY TERMS IN THE 
SEPARATE AGREEMENT WILL CONTROL.


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Safety Notices

CAUTION

A CAUTION notice denotes a hazard. It 
calls attention to an operating 
procedure, practice, or the like that, if 
not correctly performed or adhered to, 
could result in damage to the product 
or loss of important data. Do not 
proceed beyond a CAUTION notice 
until the indicated conditions are fully 
understood and met. 

WARNING

A WARNING notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, if 
not correctly performed or adhered to, 
could result in personal injury or 
death. Do not proceed beyond a 
WARNING notice until the indicated 
conditions are fully understood and 
met.
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Installation & System Operation                                                      
Introduction
Introduction
This section of this document describes system installation and operation for a banded 
millimeter-wave system using an N5261A or N5262A Millimeter Head Controller. Banded 
millimeter-wave systems are made up of three types of major components: a PNA or PNA-X, a 
controller test set, and millimeter-wave heads. These components are generally purchased 
separately and assembled into a system at the customer's site. This section of the document 
focuses on receiving the controller with accessories and then on system installation and 
operation. 

Table 1-1 on page 4 and Table 1-2 on page 5 lists compatible PNA and PNA-X models with 
required options. Table 1-3 on page 8 and Table 1-4 on page 8 list available millimeter-wave 
modules. Typical system configurations are pictured in Figure 1-1 on page 3 and Figure 1-1 on 
page 3.

The N5261A or N5262A Millimeter Head Controller may also be used as part of the N5251A 
broadband analyzer system. This application is not discussed in this manual. Refer to 
N5251-90001 for N5251A system information.

In this document the N5261A and N5262A will be referred to as the test set.

This manual should be used in conjunction with the following documents:

• PNA-X Series Network Analyzer On-line Help System 

• Millimeter-wave Technical Overview 5989-7620EN 

• OML Millimeter-wave modules (N5256-90001)

• VDI Millimeter-wave modules (N5256-90002)

• N5251A Installation and Service Guide (N5251-90001)

Network Analyzer Requirements
The required options for PNA models are indicated in the “PNA Option(s)” column of Table 1-1. 
The required options for PNA-X models are indicated in the “PNA Option(s)” column of 
Table 1-2. Note that all models require Option 020.

The minimum firmware revision for PNA models is A.09.42.16. The minimum firmware revision 
for PNA-X models is A.09.33.09. 
  2 User’s and Service Guide N5262-90001



Installation & System Operation                                                                    
Network Analyzer Requirements
Figure 1-1 2-Port Banded Millimeter-wave Configuration (N5261A)

Figure 1-2 4-Port Banded Millimeter-wave Configuration (N5262A)
User’s and Service Guide N5262-90001 3



Installation & System Operation                                                      
System Configurations
System Configurations
Table 1-1 and Table 1-2 document all supported configurations for S-Parameter measurement 
capabilities for banded mm-wave systems using the N5261A and N5262A test sets.

NOTE Capabilities: [C1]=pulse, [C2]=power control/RCVR leveling, 
[C3]=SMC+phase, [C4]=SPM, [C5]=ITSMA

Table 1-1 PNA Based Configurations 

PNA 
Model (s)

PNA 
Optionsa

a. All PNA’s require Option 020. When an N5262A is used with a 2-Port PNA, Option 551 is required.

Test Set
SRC 
Connects Ckb

b. Condition of the Route PNA RF to rear panel “RF OUT” check box. n = not checked, y = check. Refer to 
step 9 on page 40.

Cable Interface 
Kit

Cable 
Config. 
Diag(s)c

c. See Figure 1-15 through Figure 1-22 for the configuration diagrams.

Capabilities and 
Notes

N5222A 200, 201 or 
219

N5261A front n N5261A-102 A   Y [C1,C2,C3,C4__]

N5262A front n N5262A-102 B   V [C1,C2__C4,__]d 

d. Can only drive output on one port at a time in this configuration.

400, 401 or 
419

N5261A front n N5261A-104 A   Z [C1,C2,C3,C4__]

N5262A front n N5262A-104 B   X [C1,C2,C3,C4,C5]

N5224/5A 200, 201 or 
219

N5261A front n N5261A-112 A   Y [C1,C2,C3,C4__]

N5262A front n N5262A-112 B   V [C1,C2__C4,__]d

400, 401 or 
419

N5261A front n N5261A-114 A   Z [C1,C2,C3,C4__]

N5262A front n N5262A-114 B   X [C1,C2,C3,C4,C5]

N5227A

200, 201 or 
219

N5261A
front n N5261A-112 A   Y [C1,C2,C3,C4__]

rear y N5261A-112 E [C1,C2,C3,C4__]

N5262A

front n N5262A-112 B  V [C1,C2__C4,__]d

rear xxxxxx xxx
config not 
available

400, 401 or 
419

N5261A
front n N5261A-114 A   Z [C1,C2,C3,C4__]

rear y N5261A-114 E [C1,C2,C3,C4__]

N5262A
front n N5262A-114 B  X [C1,C2,C3,C4,C5]

rear y N5262A-114 F [C1,C2,C3,C4,C5]
  4 User’s and Service Guide N5262-90001
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System Configurations
Table 1-2 PNA-X Based Configurations 

PNA-X 
Model (s)

PNA
Option(s)a 

Test Set
SRC 
Connects Ckb Cable Interface 

Kit

Cable 
Config.
Diag(s)c

Capabilities and 
Notes

N5242A 200 N5261A front n N5261A-102 A   Y [C1,C2,C3,C4__]

N5262A front n N5262A-102 B   V [C1,C2__C4,__]d

200 & 224 N5261A front n N5261A-102 A   Y [C1,C2,C3,C4__]

rear y N5261A-102 C [C1,C2,C3,C4,__]

N5262A front n N5262A-102 B   W [C1,C2,C3,C4,__]

rear y N5262A-104 D [C1,C2,C3,C4,__]

400 N5261A front n N5261A-104 A   Z [C1,C2,C3,C4__]

N5262A front n N5262A-104 B   X [C1,C2,C3,C4,C5]

400 & 423 N5261A front n N5261A-104 A   Z [C1,C2,C3,C4__]

rear y N5261A-104 C [C1,C2,C3,C4,__]

N5262A front n N5262A-104 B   X [C1,C2,C3,C4,C5]

rear y N5262A-104 D [C1,C2,C3,C4,C5]

N5244/5A 200 N5261A front n N5261A-112 A   Y [C1,C2,C3,C4__]

N5262A front n N5262A-112 B   V [C1,C2__C4,__]d

200 & 224 N5261A front n N5261A-112 A   Y [C1,C2,C3,C4__]

rear y N5261A-106 C [C1,C2,C3,C4__]

N5262A front n N5262A-112 B   W [C1,C2,C3,C4__]

rear y N5262A-108 D [C1,C2,C3,C4__]

400 N5261A front n N5261A-114 A   Z [C1,C2,C3,C4__]

N5262A front n N5262A-114 B   X [C1,C2,C3,C4,C5]

400 & 423 N5261A front n N5261A-114 A   Z [C1,C2,C3,C4__]

rear y N5261A-108 C [C1,C2,C3,C4,__]

N5262A front n N5262A-114 B   X [C1,C2,C3,C4,C5]

rear y N5262A-108 D [C1,C2,C3,C4,C5]

Continued on Page 6
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PNA-X 
Model (s)

PNA 

Option(s)a
Test Set SRC 

Connects
Ckb Cable Interface 

Kit
Conn. 

Diag(s)c
Capabilities and 
Notes

N5247A 200 N5261A front n N5261A-112 A   Y [C1,C2,C3,C4__]

rear y N5261A-102 E [C1,C2,C3,C4__]e

N5262A front n N5262A-112 B   V [C1,C2,C3,C4__]d

rear xxxx xxxx config not available

200 & 224 N5261A front n N5261A-112 A   Y [C1,C2,C3,C4__]

rear y N5261A-102 E [C1,C2,C3,C4,__]f

N5262A front n N5262A-112 B   W [C1,C2,C3,C4__]

rear y N5262A-104 F [C1,C2,C3,C4,__]

400 N5261A front n N5261A-114 A   Z [C1,C2,C3,C4__]

rear y N5261A-102 E [C1,C2,C3,C4,__]g

N5262A front n N5262A-114 B   X [C1,C2,C3,C4,C5]

rear y N5262A-104 F [C1,C2,C3,C4,C5]

400 & 423 N5261A front n N5261A-114 A   Z [C1,C2,C3,C4__]

rear y N5261A-104 E [C1,C2,C3,C4,__]f

N5262A front n N5262A-114 B   X [C1,C2,C3,C4,C5]

rear y N5262A-104 F [C1,C2,C3,C4,C5]h

a. All PNA-X’s require Option 020. When an N5262A is used with a 2-Port PNA-X, Option 551 is required.
b. Condition of the Route PNA RF to rear panel “RF OUT” check box. n = no, y = check, x = don’t care. Refer 

to step 9 on page 40.
c. See Figure 1-15 through Figure 1-22 for configuration diagrams.
d. Can only drive output on one port at a time in this configuration.
e. Must use RF OUT on the rear panel.
f. Must use RF OUT or RF1 OUT on the rear panel. Options 224 and 423 do not provide rear panel 

connections for Port 1. Functionality is the same as PNA-X without Option 224/423.
g. Must use RF1 OUT on the rear panel.
h. Must use RF OUT or RF2 OUT on the rear panel. Functionality is the same as PNA-X without Option 

224/423.

Table 1-2 PNA-X Based Configurations 
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Compatible mm-wave Modules
Keysight offers millimeter modules manufactured by Olsen Microwave Labs (OML) and Virginia 
Diodes Inc (VDI) for use with the N5261/62A for banded mm-wave network analyzer systems. 
Refer to Table 1-3, “Available OML Modules,,” on page 8 and Table 1-4, “Available VDI 
Modules,,” on page 8.

Transmission/Reflection millimeter-wave modules contain an RF source multiplier, dual 
directional coupler, reference downconverter and a test downconverter. The 
Transmission/Reflection millimeter-wave module is usually the primary module of a 
millimeter-wave VNA system. A single Transmission/Reflection module allows the 
measurement of S11 reflection coefficient only. Refer to Figure 1-3.

“Receive only” millimeter-wave modules contain a test downconverter to receive the test signal 
from a Transmission/Reflection millimeter-wave module. The use of a Receiver module, as the 
second module, allows the system capability to measure S11 and S21 only.

The use of two Transmission/Reflection modules in the millimeter-wave VNA system allows for 
all four S-parameters to be measured. The test downconverters of Transmission/Reflection 
modules are the receivers for the signal from the modules sources. When the two modules 
waveguide are connected, S11 and S21 are measured in the forward direction, S22 and S12 are 
measured when the signal path is reversed. If a 4-Port system is configured with 
Transmission/Reflection modules, all 16 S-parameter measurements can be made on a 4-Port 
device.

Figure 1-3 Module Configurations

S22

TxRx DUT

S11

TxRx TxRxDUT

S11

S21

S12

TxRx RxDUT

S11

S21

Full 2-Port 

Measurements

Thru Reflection 

Measurements

Reflection

Measurements
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Table 1-3 Available OML Modulesa,b

a. The Interface cable set is not supplied, refer to Table 1-6 on page 10.
b. Adjustable RF Attenuator, RF & LO internal amplifiers options are available. Refer to OML millime-

ter-wave modules documentation (N5256-90001).

Banded Freq 
Ranges (GHz)

Port Type Source Receiver Model # Notes

33 to 500 Waveguide √ √ N5256AWxx T/R Module

33 to 500 Waveguide √ N5257ARxx Receiver

33 to 500 Waveguide Dual N5258ADxx Receiver-Dual

Table 1-4 Available VDI Modulesa,b 

a. The Interface cable set is supplied with each VDI module. Do not order cable Options 501, 502, 503 and 
505.

b. These modules are compatible with the test set only. They are provided with their own power supply, 
do not connect to the test set DC power port. Refer to VDI millimeter-wave modules documentation 
(N5256-90002). 

Banded Freq 
Ranges (GHz)

Port Type Source Receiver Model # Notes

750 to 1100 Waveguide √ √ N5262AW01-TST T/R Module

500 to 750 Waveguide √ √ N5256AW01-TST T/R Module

50 to 500 Waveguide √ √ N5262AWxx-TST T/R Module

750 to 1100 Waveguide  √ N5262AR01-TST Receiver

500 to 750 Waveguide √ N5256R01-TST Receiver

50 to 500 Waveguide √ N5262ARxx-TST Receiver
  8 User’s and Service Guide N5262-90001
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Verifying Your Shipment
To verify the contents shipped with your product, refer to the “Box Content List” included with 
the shipment. For a list of option components, refer to Table 1-6 on page 10.

Inspect the shipping container. If the container or packing material is damaged, it should be 
kept until the contents of the shipment have been checked mechanically and electrically. If 
there is physical damage refer to “Contacting Keysight” on page 86. Keep the damaged 
shipping materials (if any) for inspection by the carrier and a Keysight Technologies 
representative. 

CAUTION The N5261/62A Millimeter Head Controller and the millimeter-wave modules 
are sensitive to electrostatic d ischarge (ESD). Ground your work station before 
unpacking and installing the millimeter-wave modules. See “Electrostatic 
Discharge Protection” on page 85.

Option List Information

Use the tables below to verify that your specific option shipment is complete. 

Table 1-5 N5261/62A Standard Content 

√
Keysight 
Part Number

Ref Des Description Qty

N5261A or 
N5262A 

Millimeter Head Controller Test Set 1

1810-0118 
(N5261A)

Coax Termination, 50 Ohm, male (load) 1

1810-0118 
(N5262A)

Coax Termination, 50 Ohm, male (load) 2

N4011-21002 W7
Multi-Cond Flex CA AY - DSub25 m/m, 
520mm (20in), Rear Panel Connections

1

9230-0333 Envelope (Calibration Certificate) 1

9320-6636 Functional Certificate 1

N5262-90001 User’s and Service Guide 1

N5256-90001 OML Module Product Note 1

N5256-90002 VDI Module Product Note 1
User’s and Service Guide N5262-90001 9
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Table 1-6 N5261A Interface Kits  

√
Keysight 
Part Number

Ref Des Description Qty

N5261A Option 102 (Interface Kit for 2-Port PNA N5222/42A))

5061-9038 W5, 
W8-W12

Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

6

N5262-20016 W1 Coax Rigid CA-Assy, SMA (m/f), (SRC1 to 2-Port PNA) 1

U3021-60002 Lock Link Kit, Test Set to PNA-X 1

N5261A Option 104 (Interface Kit 4-Port PNA N5222/42A)

5061-9038 W5, 
W8-W12

Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

6

N5262-20018 W1 Coax Rigid CA-Assy, SMA (m/f), (SRC1 to 4-Port PNA) 1

U3021-60002 Lock Link Kit, Test Set to PNA 1

N5261A Option 106 (Interface Kit 2-Port PNA N5224/25/44/45A)

5061-9038 W5, 
W8-W12

Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

6

N5262-20023 W1
Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC1 to 2-Port PNA)

1

N4903-61250 Coax Adapter (3.5 mm female to 2.4 mm male) 1

U3021-60003 Lock Link Kit, Test Set to PNA 1

N5261A Option 108 (Interface Kit 4-Port PNA N5224/25/44/45A)

5061-9038 W5, 
W8-W12

Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

6

N5262-20026 W1
Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC1 to 4-Port PNA)

1

N4903-61250 Coax Adapter (3.5 mm female to 2.4 mm male) 1

U3021-60003 Lock Link Kit, Test Set to PNA 1

N5261A Option 112 (Interface Kit 2-Port N5227/47A)

5061-9038 W5, 
W8-W13

Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

7

N5262-20023 W1
Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC1 to 2-Port PNA)

1

U3021-60003 Lock Link Kit, Test Set to PNA 1

N5261A Option 114 (Interface Kit 4-Port N5227/47A)

5061-9038 W5, W6, 
W8-W13

Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

8

N5262-20026 W1
Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC1 to 4-Port PNA)

1

U3021-60003 Lock Link Kit, Test Set to PNA 1
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Table 1-7 N5262A Interface Sets  

√
Keysight 
Part Number

Ref Des Description Qty

N5262A Option 102 (Interface Kit 2-Port N5222/42A)

5061-9038 W5, 
W8-W13

Coax Flex CA-Assy - SMA (m/m), 520 mm (20 in), 
rear panel connections

7

N5262-20016 W1
Coax Rigid CA-Assy, SMA male to female (SRC1 to 
2-Port PNA)

1

N5262-20017 W3
Coax Rigid CA-Assy, SMA male to female (SRC2 to 
2-Port PNA)

1

N5262-20020 W2
Coax Rigid CA-Assy, SMA male to female (SRC2 to 
2-Port PNA)

1

U3021-60002 Lock Link Kit, Test Set to PNA 1

N5262A Option 104 (Interface Kit 4-Port N5222/42A)

5061-9038 W5, W6, 
W8-W13

Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

8

N5262-20018 W1
Coax Rigid CA-Assy, SMA male to female (SRC1 to 
4-Port PNA)

1

N5262-20019 W2
Coax Rigid CA-Assy, SMA male to female (SRC2 to 
4-Port PNA)

1

U3021-60002 Lock Link Kit, Test Set to PNA 1

N5262A Option 106 (Interface Kit 2-Port N5224/25/44/45A) 

5061-9038 W5, 
W8-W13

Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

7

N5262-20023 W1
Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC1 to 2-Port PNA)

1

N5262-20024 W3
Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC2 to 2-Port PNA)

1

N5262-20025 W2
Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC2 to 2-Port PNA)

1

N4903-61250 Coax Adapter (3.5 mm female to 2.4 mm male) 2

U3021-60003 Lock Link Kit, Test Set to PNA 1

Continued on Page 12
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N5262A Option 108 (Interface Kit 4-Port N5224/25/44/45A)

5061-9038 W5, W6, 
W8-W13

Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

8

N5262-20026 W1
Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC1 to 4-Port PNA)

1

N5262-20027 W2
Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC2 to 4-Port PNA)

1

N4903-61250 Coax Adapter (3.5 mm female to 2.4 mm male) 2

U3021-60003 Lock Link Kit, Test Set to PNA 1

N5262A Option 112 (Interface Kit 2-Port N5227/47A)

5061-9038
W5, 
W8-W13

Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

7

N5262-20023 W1
Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC1 to 2-Port PNA)

1

N5262-20024 W3
Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC2 to 2-Port PNA)

1

N5262-20025 W2
Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC2 to 2-Port PNA)

1

U3021-60003 Lock Link Kit, Test Set to PNA 1

N5262A Option 114 (Interface Kit 4-Port N5227/47A)

5061-9038 W5, W6, 
W8-W13

Coax Flex CA-Assy - SMA (m/m), 
520 mm (20 in), rear panel connections

8

N5262-20026 W1
Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC1 to 4-Port PNA)

1

N5262-20027 W2
Coax Rigid CA-Assy, SMA male to 2.4 mm female 
(SRC2 to 4-Port PNA)

1

U3021-60003 Lock Link Kit, Test Set to PNA 1

Table 1-7 N5262A Interface Sets (Continued) 
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Table 1-8 Test Set to the Module Cable Sets  

√
Keysight 
Part Number

Description Qty

Option 501 (1-Port Trans/Refl Cable Set (48 inches = 1.2 meter))

1250-2604 Coax Connector Adapter, right angle- SMA m/f 2

8121-1221 Coax flex CA-Assy, 3.5 mm male to male, 1.2 m (48 in) - RF & LO 2

85105-60030 Multi-Cond Flex CA-Assy, Cir 7C, 1.2 m (48 in) - DC Power Bias 1

85105-60048
Coax flex CA-Assy, right angle- SMA m/m 1.2 m (48 in) - Ref & 
Test IF

2

N5261-60019 Cable Sleeve and Marker Kit, 1.2 m (48 in) 1

Option 502 (1-Port Trans/Refl Cable Set (79 inches = 2 meter))

1250-2604 Coax Connector Adapter, right angle- SMA m/f 2

N5260-60023 Coax flex CA-Assy, 3.5 mm male to male, 2 m (79 in) - RF & LO 2

N5260-60070
Coax flex CA-Assy, right angle SMA m/m, 2 m (79 in) - Ref & Test 
IF

2

N5260-60025 Multi-Cond Flex CA-Assy, Cir 7C, 2 m (79 in) - DC Power Bias 1

N5261-60020 Cable Sleeve and Marker Kit, 5 m (197 in) 1

Option 503 (1-Port Trans/Refl Cable Set (118 inches = 3 meter))

1250-2604 Coax Connector Adapter, right angle- SMA m/f 2

N5260-60026 Coax flex CA-Assy, 3.5 mm male to male, 3 m (118 in) - RF & LO 2

N5260-60027
Coax flex CA-Assy, right angle SMA m/m, 3 m (118 in) - Ref & Test 
IF

2

N5260-60028 Multi-Cond Flex CA-Assy, Cir 7C, 3 m (118 in) - DC Power Bias 1

N5261-60020 Cable Sleeve and Marker Kit, 5 m (197 in) 1

Option 505 (1-Port Trans/Refl Cable Set (197 inches = 5 meter))

1250-2604 Coax Connector Adapter, right angle- SMA m/f 2

N5260-60029 Coax flex CA-Assy, 3.5 mm male to male, 5 m (179 in) - RF & LO 2

N5260-60071
Coax flex CA-Assy, right angle SMA m/m, 5 m (179 in) - Ref & Test 
IF

2

N5260-60072 Multi-Cond Flex CA-Assy, Cir 7C, 5 m (197 in) - DC Power Bias 1

N5261-60020 Cable Sleeve and Marker Kit, 5 m (197 in) 1
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Table 1-9 Rackmount Front Handle Kits 

√
Keysight 
Part Number

Description Qty

Option 1CM (Rackmount Kit without Front Handles)

5063-9215 Rackmount Kit - 177.OH-without Handle 1

Option 1CN (Front Handle Kit)

5063-9228 Front Handle Kit - 177.OH 1

Option 1CP (Rackmount Kit with Front Handle Kit)

5063-9222 Rackmount Kit with handle- 177.OH 1
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Specifications
The following information is provided to confirm the operation of the N5261/62A. 

General Characteristics

CAUTION This product is designed for use in Installation Category II and Pollution 
Degree 2.

Required Conditions for Accuracy Enhanced Measurement

Accuracy-enhanced (error-corrected) measurements require the ambient temperature of the 
N5261/62A to be maintained within ± 1 °C of the ambient temperature at calibration.

The instrument can safely operate in a relative humidity of 80% for temperatures to 31 degrees 
C, decreasing linearly to 50% relative humidity at 40 degrees C.

CAUTION Ventilation Requirements: When installing the instrument in a cabinet, the 
convection into and out of the instrument must not be restricted. The 
ambient temperature (outside the cabinet) must be less than the maximum 
operating temperature of the instrument by 4 °C for every 100 watts 
dissipated in the cabinet. If the total power dissipated in the cabinet is 
greater than 800 watts, forced convection must be used.

Environmental:

Temperature 20 to 30 °C

Altitude 3,000 meters (9,842 ft)

EMC Samples of this product Meets radiated and conducted 
emission requirements of IEC 60068-2 and levels are similar to 
MIL-PRF-28800F Class 3.

Power Requirements:

Nominal Frequency Range 50/60 Hz

Nominal Voltage Range 100/120/220/240 Vac

N5261A or N5262A Power 350 Watts

Weight and Dimensions:

Net Weight N5261A 10 kg (22 lb)
N5262A 11 kg (24.2 lb)

Dimensions Height: 18 cm (7.1 in)   
Width: 42.5 cm (16.75 in)
Depth: 42.5 cm (16.75 in)
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Table 1-10 Characteristics and Specifications 

Front/Rear Panel Connectora 

a. All connectors are SMA female.

Power Levels (dBm)
Gain Frequency 

Min Typ Maxb

b. Do not exceed the maximum level or damage may occur.

N5261A 

TEST or REF IF (Input) (characteristic) - -27 -10 - 7.6 MHz

TEST IF to A/B/C/D IF OUTPUT 
(specification) See Figure 2-4 on page 55.

- - - -1.5 dB (± 1) 7.6 MHz

REF IF to A/B/C/D IF OUTPUTS 
(specification) See Figure 2-4 on page 55.

- - - -1.5 dB (± 1) 7.6 MHz

REF IF to R IF OUTPUTS (specification) 
See Figure 2-4 on page 55.

- - -1.5 dB (± 1) 7.6 MHz

LO IN (characteristic) -10 - 2 - 8 to 19 GHz

LO OUT (specification)c 
See Figure 2-1 on page 50.

c. With a -3 dBm Input, measure on the test set connector. See Figure 2-1 on page 50. 

10 11.5 14.5 >14.5 dB 8 to 19 GHz

SRC1 RF IN (characteristic) 0 - 15 - 8 to 19 GHz

RF OUT (specification)d
See Figure 2-2 on page 52.

d. ALC on and with 0 dBm Input, measure on the test set connector. See Figure 2-2 on page 52. 

10 11.5 14.5 >14.5 dB 8 to 19 GHz

N5262A 

TEST or REF IF (Input) (characteristic) - -27 -10 - 7.6 MHz

Test IF to A/B/C/D IF OUTPUTS 
(specification) See Figure 2-4 on page 55.

- - -2 dB (± 1) 7.6 MHz

Ref IF to A/B/C/D IF OUTPUTS 
(specification) See Figure 2-5 on page 55.

- - -4 dB (± 1.5) 7.6 MHz

Ref IF to R IF OUTPUTS (specification) See 
Figure 2-6 on page 55.

- - -5 dB (± 1.5) 7.6 MHz

LO IN (characteristic) -10 - 2 - 8 to 19 GHz

LO OUT (specification)c
See Figure 2-1 on page 50.

10 11.5 14.5 14.5 dB 8 to 19 GHz

SRC1 or SRC2 RF IN (characteristic) 0 - 15 - 8 to 19 GHz

RF OUT (specification)d
See Figure 2-2 on page 52.

10 11.5 14.5 14.5 dB 8 to 19 GHz
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Cable Loss Between the Test Set and the Module
If the cables between the test set and the millimeter-wave modules are longer than four feet, 
cable loss for the RF and LO paths may be excessive. Perform the analysis recommended below. 

Determine the input power level requirements for the millimeter-wave module selected for use. 
Refer to the documentation included with your module. To determine the power available at the 
module, calculate the cable loss using Figure 1-4 or Table 1-11, then subtract the cable loss 
from the RF and LO Out characteristic power of 10 dBm. You may also use a power meter. 

A separate DC supply is recommended for OML modules if they are greater than 5 meters from 
the controller. A DC bias power cable, with banana plug connectors, is available for use with a 
separate power supply such as E3615A for OML modules. VDI modules have a DC power supply 
included with the module.

If you are installing an external amplifier in the LO or RF path, ensure the amplifier’s input is 
connected to the test set, and the output is connected to the mm-wave module’s LO or RF 
Input. Modules with internal amplifiers are available. 

Figure 1-4 Typical RF Cable Loss (dB loss per foot)

Table 1-11 Typical Cable Insertion Loss 

Cable 
Option

Cable Length 7 GHz 10 GHz 18 GHz

501 4 ft. (1.22 m) 1 dB 1.2 dB 1.6 dB

502 6.58 ft. (2 m) 1.65 dB 2 dB 2.65 dB

503 9.83 ft. (3 m) 2.5 dB 3 dB 4 dB

505 16.4 ft. (5 m) 4.1 dB 5 dB 6.6 dB
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Front Panel Features

Figure 1-5 N5261A (2-Port) Front Panel Features

Figure 1-6 N5262A (4-Port) Front Panel Features
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TEST IF

IF signal input connection from the millimeter module’s Test or Measure IF Output. 

REF IF

Reference IF signal input connection from the millimeter module’s Reference IF Output.

RF OUT

Provides an amplified RF source signal to the millimeter-wave module’s RF Input.

LO OUT

Provides amplified LO signal to the millimeter-wave module’s LO Input.

SRC1 and SRC2 

Connects to the analyzer’s front panel Test Ports for RF Output power.

Port Status LEDs

The amber LEDs indicate which source port is active. The green LEDs indicate which receiver 
port is active. All receivers are active in normal operation.

DC Power (Bias)

This bias supplies the +12 Vdc and ground lines for OML millimeter-wave modules. Pins 1 and 3 
are both +12 Vdc supplies. Pins 4 and 6 are the dc supply ground lines. Pins 2, 5, and 7 are 
unused. The DC power connections are intended for use with OML modules.

DC Power/Over Current LEDs

The green LEDs indicate that the DC power bias is on. The amber LEDs indicate an over current 
condition.

Standby Switch

The switch is only a Standby switch, not a AC line power switch. 

Active LED

When the test set is connected and addressed by a analyzer, the LED is On (illuminated). The 
LED is Off (not illuminated) when the test set is in Standby, or not addressed by the analyzer.

NOTE The SRC2 Input and Ports 3 and 4 features are not present on the N5261A. 
Refer to Figure 1-1 on page 3.
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Rear Panel Features

Figure 1-7 N5261A Rear Panel Features

Figure 1-8 N5262A Rear Panel Features 
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IF OUTPUTs – SMA (female)

• D (from the test set to the analyzer’s IF D Input)

• C (from the test set to the analyzer’s IF C Input)

• R (from the test set to the analyzer’s IF R Input, not installed in the N5261A)

• A (from the test set to the analyzer’s IF A Input)

• B (from the test set to the analyzer’s IF B Input)

LO IN

This input is from the LO drive of the analyzer. The signal is split and amplified and then output 
to the front panel of the N5261/62A.

SRC 1 RF IN and SRC 1 RF OUT

Test set rear panel RF Input access for use with the analyzer’s Option 224 or 423. 
SRC 1 provides the power input for RF OUT Ports 1 & 2.

SRC 2 RF IN and SRC 2 RF OUT (Not installed in the N5261A)

Rear panel RF Input access for use with the analyzer’s Option 224 or 423. 
SRC 2 provides the power input for RF OUT Ports 3 & 4. 

Chassis Ground

A threaded terminal post for connecting the test set to a conductive object, cabinet or structure 
to ensure a common potential and reduce leakage current in a system. Requires an English 
1/4-20 thread nut (0140-0084) and lock washer (2190-0067).   

Pass Through Interface

Connection to another test set.

Test Set I/O

The test set interface connector is used to send address and data to the test set from the 
analyzer.

Line Module

This assembly houses the line cord connection, line fuse, and line voltage selector. Remove the 
line module cover to replace or change the fuse. Line voltage selection is automatic and no 
setting is required. Recommended fuse values are printed on the rear panel of the N5261/62A.

Power Cords

A line power cord is supplied in one of several configurations, depending on the destination of 
the original shipment. Keysight can supply additional certified power cords to meet region 
electrical supply and receptacle configurations. Please refer to our website at: 
http://www.keysight.com for assistance in power cord selection. 
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Available Fuses

•  Fuse (F 5 A/250V, 2110-0709) UL listed and CSA certified.

WARNING For continued protection against fire hazard replace line fuse only with 
same type and rating. The use of other fuses or material is prohibited.

Figure 1-9 Line Fuse 

CAUTION Verify that the premise electrical voltage supply is within the range 
specified on the instrument.
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Site Preparation

Install the instrument so that the detachable power cord is readily identifiable and is easily 
reached by the operator. An externally installed switch or circuit breaker (which is readily 
identifiable and is easily reached by the operator) should be used as the disconnecting 
device.The detachable power cord can also be used to disconnect the mains circuits from the 
mains supply before other parts of the instrument. The front panel switch is only a standby 
switch and is not a LINE switch. 

Protect Against Electrostatic Discharge (ESD)

This is important. If not properly protected electrostatic discharge can seriously damage your 
analyzer, resulting in costly repair.

CAUTION To reduce the chance of electrostatic discharge, follow all of the 
recommendations outlined in “Electrostatic Discharge Protection” on page 85.

Table 1-12  Power Requirements of a Standard Configuration

Standard Equipment

Instrument Maximum Watt 

N5222A, N5224A, N5225A or N5227A 450

N5242A, N5244A, N5245A or N5247A 450

N5261/62A Millimeter Head Controller 350

Millimeter-wave Module (OML) (powered from controller)

Millimeter-wave Module (VDI) 175
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System Setup

It is recommended that you connect the cables to the rear panel of the test set before mounting 
the analyzer on top of the test set. When the analyzer is mounted on the test set, the back of 
the analyzer extends over the rear panel of the test set and may interfere with access to the rear 
panel connectors. The cables can then be connected to the analyzer after it is mounted on the 
test set. Table 1-1 on page 4 or Table 1-2 on page 5 indicates which connection diagrams to 
use for your configuration. 

WARNING The network analyzer is heavy. It is recommended that two individuals, or 
a mechanical lift be used to lift or transport the instrument.

Mounting a Network Analyzer on the Test Set 

1. Refer to the following kits for your specific analyzer. In this procedure a N5242A 4-Port 
PNA-X is used with a N5262A. There are other kits available via the U3021M model. Refer to 
“Keysight Support, Services, and Assistance” on page 86 for ordering information.

• Locking Kit (U3021-60002) for the test set. Includes the Locking kit (5023-0132) and screws 
(0515-2317) to connect the test set to the N5222A PNA or N5242A PNA-X. The 
N5242-20138 is the right foot and N5242-20139 is the left. 

• Locking Kit (U3021-60003) for the test set. Includes the Locking kit (5023-0132) and screws 
(0515-2317) to connect the test set to the N5224/25/27/A PNA or N5244A/45/47A PNA-X. 
The N5242-20130 is the right foot and N5242-20131 is the left foot.

1. Remove the feet from the bottom of the analyzer.

2. Remove the 2 lower standoffs from the rear panel on the analyzer. 

Figure 1-10 Rear Bottom Feet

Standoffs (x2)

Feet (x4)
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3. Install the two rear locking feet from the (5023-0132) onto the analyzer, where the standoffs 
were removed. 

Figure 1-11 Install Locking Feet on Network Analyzer

4. Remove the top two standoffs from the rear panel on the test set.

5. Install the two rear locking feet from the kit (U3021-60002) onto the test set using two 
screws (0515-2317), included in shipment. Looking at the rear panel, the N5242-20139 is 
the left foot and the N5242-20138 is the right foot. 

Figure 1-12 Rear Locking Feet (N5222A or N5242A)

Locking Foot from 
kit (5023-0132)

N5242-20138N5242-20139

0515-2317 (x2
User’s and Service Guide N5262-90001 25



Installation & System Operation                                                      
System Configuration and Operation
6. Place the analyzer on top of the test set and ensure that the front frame of the analyzer is 
positioned slightly forward of the locks that are attached to the test set. Slide the analyzer 
back so the locks engage the front frame of the analyzer.
 

Figure 1-13 Locking the Analyzer

7. Secure the analyzer’s lower locking feet to the test set’s upper locking feet using the 
spring–loaded screws on the locking feet. Refer to Figure 1-14 on page 27. If the locking feet 
are not aligned with the screw holes in the test set's upper locking feet, loosen the screws 
securing the feet to the instrument slightly to align and tighten.

Figure 1-14 Locking Feet Screws 

Test Set
Front Frame

Network Analyzer
Front Frame

Slide the network Analyzer
back to engage the lock link
in the back of the network
analyzer's front frame

Lock Link
screw

Slide the network analyzer
back to engage the lock link in 
the back of the network 
analyzer’s front frame,

 
 Locking Screw Locking Screw 
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Rear Panel Connections

Rear panel connections are documented in Figure 1-15 through Figure 1-20. Refer to 
Table 1-1 on page 4 and Table 1-2 on page 5 to determine which figure applies to your 
configuration. 

Figure 1-15 N5261A Rear Panel Configuration A

From:
PNA/PNA-X

D/R2 C/R1 Test Set I/O LO OUT (J5) B A

To: N5261A 
Controller

D C Test Set I/O LO IN B A
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Figure 1-16 N5262A Rear Panel Configuration B

From:
PNA/PNA-X

D/R2 C/R1 R Test Set I/O
LO OUT 
(J5)

B A

To: N5262A 
Controller

D C R Test Set I/O LO IN B A
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Figure 1-17 N5261A Rear Panel Configuration C

From:
PNA/PNA-X D/R2 C/R1 Test Set I/O

LO OUT 
(J5)

B A SW SRCa 
OUT (J11)

a. Install the adapter (N4903-61250) on the N5224/25A or N5244/45A SW SRC OUT (J11).

To: N5261A 
Controller

D C Test Set I/O LO IN B A SRC 1 RF IN 
(Port1 SW SRC)
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Figure 1-18 N5262A Rear Panel Configuration D

From:
PNA/PNA-X D/R2 C/R1 R

Test Set 
I/O

LO OUT 
(J5)

B SW SRCa 
OUT (J8)

A SW SRCa 
OUT (J11)

a. Install the adapters (N4903-61250) on the N5224/25A or N5244/45A SW SRC OUT (J8 and J11).

To: N5262A 
Controller D C R

Test Set 
I/O

LO IN B
SRC 2 RF IN 
(SRC 2 SW 
SRC) 

A
SRC1 RF IN 
(Port 1 SW 
SRC)
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Figure 1-19 N5261A Rear Panel Configuration E

From:
PNA/PNA-X

D/R2 C/R1 Test Set I/O
LO OUT 
(J5)

B A
RF 1 OUT
(J6)

To: N5261A 
Controller

D C Test Set I/O LO IN B A
SRC 1 RF IN 
(Port 1 SW SRC)
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Figure 1-20 N5262A Rear Panel Configuration F

From:
PNA/PNA-X

D/R2 C/R1 R
Test Set 
I/O

LO OUT 
(J5)

RF 2 OUT
(J12)

B
RF 1 OUT
(J6)

A

To: N5262A 
Controller D C R

Test Set 
I/O

LO IN
SRC 2 RF IN 
(SRC 2 SW 
SRC) 

B
SRC1 RF 
IN (Port 1 
SW SRC)

A
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PNA and PNA-X Front Panel Connections

Some system configurations require SRC connections between the analyzer’s ports and the 
front panel of the test set. Refer to Table 1-1 on page 4 and Table 1-2 on page 5 to determine if 
these connections are necessary for your configuration. Figure 1-21 and Figure 1-22 provide the 
connection diagrams.

Figure 1-21 N5261A Front Panel Configuration Y and Z

Figure 1-22 N5262A Front Panel Configuration V and X
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Millimeter-wave Module Cable Connections 

Before connecting the millimeter-wave modules, verify that the test set and the power supplies 
(if used) are powered down.

There are four RF cables for each T/R module. Cables provided with the VDI modules are 
pre-labeled. The cables for use with the OML modules come in two types, two lighter and two 
heavier. Use the lighter cables for the IF signals and the heavier cables for the RF and LO 
signals.

Figure 1-23 Example; OML Module Connections

Figure 1-24 Example; VDI Module Connections

DC Bias
REF IF

TEST IF
RF LO

REF IF

M EAS IF
RF

LO

I

O

Power Supply

Each module has 
a separate power 
supply.
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The following detailed instructions are for connecting an OML T/R module. These instructions 
assume a cable dress kit (black sleeving) is available. Modify the instructions appropriately for 
other types of modules.

1. Prepare the cable bundle comprised of five cables listed in Table 1-13.

a. Complete Steps 1 through 5 of the Installation Guide from the Millimeter-wave Cable 
Dress Kit (document number N5260-90070 contained in kit part number N5261-60019). 
DO NOT APPLY THE VELCRO ASSEMBLIES AT THIS TIME.

2. Connect the five cables to the front panel of the controller in the following order. Use two 
right angle adapters (1260-2604). 

Figure 1-25 Controller Front Panel Connections

3. Repeat step 1 and step 2 for each module in the system.

Table 1-13 Controller Connections

Order Test Set Module (OML)

1 DC POWER +12 V

2 TEST IF Test I.F.

3 REF IF Ref I.F.

4 RF OUT R.F. In

5 LO OUT L.O. In
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4. Select a Millimeter-wave module and place it on the work surface in front of the test set.

5.  Connect the bundle of cables to the module in the following order. 

Figure 1-26 Test Head Module Connections

6. Repeat step 4 and step 5 for the remaining modules.

7. Apply Velcro assemblies to the ends of the cable sleeves.

a. Complete steps 6, 7 and 8 of the Installation Guide from the Millimeter-wave Cable Dress 
Kit (document number N5260-90070 contained in kit part number N5261-60019 and 
N5261-90020). 

8. Position each test head in the approximate location where it will be used for measurement 
operations.

9. Torque all RF connections to 8 in-lb. 

Table 1-14 Millimeter Head Connections

Order Module (OML)

1 +12 V

2 R.F In

3 L.O. In

4 Ref I.F.

5 Test I.F.
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Configuring the Network Analyzer Firmware

This section will describe how to set up and operate the N5261/62A Millimeter Head Controller 
with your network analyzer. 

The N5261/62A Millimeter Head Controller is considered a “slave” instrument. A network 
analyzer must be used to control the test set. 

CAUTION Before turning on this instrument, verify that the AC supply voltage is in the 
specified range.

Typeface Key Conventions

The following key conventions are used throughout this document.

• [HARDKEYS] are labeled front panel keys.

• SOFTKEYS are indicated on the instrument display.

Before Beginning this Section

Determine the multiplier factors to use for RF IN and LO IN. The factors for each head are 
indicated on the labels located on the top of each head (near the RF and LO connectors).

NOTE The maximum frequency of RF signals from the PNA-X rear panel is 19 GHz.
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Millimeter Mode 

The Millimeter mode allows you to configure the system for the millimeter-wave module you 
are using. Refer to the analyzer’s Help menu for more information. 

The following instructions assume the system has not been configured for the desired heads.

1. Connect your system and turn on all of the equipment.

2. To access the millimeter application select [System] > Configure > Mill imeter Module. 

3. Select the test set you are using from the drop-down menu (N5261A or N5262A).

4. Click the New command button.

5. In the “Selected Configuration” dialog box enter a title, such as “WR15” to replace “Config 
1”. 

Figure 1-27 Banded Configuration 

6. Enter the Multiplier RF IN number. Example: (WR15 = 4). Refer to Figure 1-28 and the 
documentation shipped with your module.

7. Enter the Multiplier LO IN number. Example: (WR15 = 5) Refer to Figure 1-28 and the 
documentation shipped with your module.

8. In the Test Port Frequency dialog box enter the Start and Stop Frequency of the 
millimeter-wave module. Example: (WR15 = 50 GHz and 75 GHz)
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9. Select or clear the “Route PNA RF to rear panel “RF OUT” check box as indicated in Table 1-1 
on page 4 or Table 1-2 on page 5.

10.Set the ALC mode according to the following information:

For most applications the ALC mode should be on “Enable Test Set RF ALC” box checked. 
For this condition “Max Power Limit at Multiplier’s RF IN” is automatically set to 11 dBm. The 
hardware ALC’s in the test set provide a nominal 
11 dBm power level at the RF inputs to the extender modules. This applies to both the RF 
and LO inputs. A nominal cable loss between the test set and extender modules is assumed. 

If the ALC mode “Enable Test Set RF ALC” is off, the max power may be set by the user in the 
“Max Power Limit at Multiplier’s RF IN” dialog box. If the user adjusts the analyzer’s RF 
power, the RF power into the millimeter-wave modules will change, but will not exceed the 
specified max power in the dialog box. It is recommended that ALC “Enable Test Set RF ALC” 
be turned off in Pulse mode. Without ALC the power control is less accurate. 

11.Select OK. The analyzer will preset for millimeter operation after you select OK in the next 
dialog window. 

Figure 1-28 Millimeter System Selections 

NOTE Select the “Standard PNA” configuration to return to normal PNA operation 
without the heads. 
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System Operation Verification

• The Banded System Check verifies the configured system is operating correctly. It requires 
all system components. 

• If a problem is suspected with the N5261A or N5262A test set, refer to“Test Set Operation 
Check” on page 46 and “Test Set Troubleshooting” on page 59. 

Banded System Check

The Banded System operational verification procedure confirms that the system is operating 
correctly. There are no hard specifications for the system measurement performance, but 
guidelines are provided for evaluating the system operation results. 

The purpose of the Operation Check is to detect significant degradations in the system that 
make the performance unacceptable. The calibration kit and test environment can affect the 
System Operation Check results. Refer to “Site Preparation” on page 24.

When any part of the operator’s check provides unsatisfactory results, refer to “System Level 
Troubleshooting” on page 45 to determine the cause of the problem.

Required Equipment

• Waveguide Short

• Data for your mm-wave modules receivers

• 3/32 Ball Driver (OML), or 5/64 Ball Driver (VDI)

• 5/16 Open end Torque Wrench, 8 in-lb.
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Preparing the Network Analyzer

1. Connect the analyzer, test set and the millimeter-wave band modules as described in 
“System Configuration and Operation” on page 24.

2. Turn on the test set and the analyzer.

3. Configure the analyzer for operation with the millimeter-wave modules. Refer to 
“Configuring the Network Analyzer Firmware” on page 38. Refer to the Help menu for further 
information. 

Procedure

This procedure assumes that you have a Transmission/Reflection module on each port. If not, 
the procedure will have to be modified appropriately.

The Operational Check procedure verifies that the banded system is connected correctly and 
the modules, test set and analyzer are operating properly. 

1. Allow the system to warm up for at least 30 minutes.

2. Attach a waveguide extension section to each module’s waveguide flange port to protect the 
modules waveguide connector. 

3. Verify that the analyzer is in Millimeter mode and that the frequency range is correct for the 
configured millimeter system.

4. To verify the port as a receiver, perform the following steps: 

a. Connect a short to Port 1. 

b. Display all receivers on the analyzer’s screen using the following menu selections: 
[System] > Service > Utilities > Receiver Display. 

c. Compare the A,1 and R1,1 traces to the data for your modules Test and Reference 
receivers. The general shape should be similar, but not necessarily identical to the 
graphics in the module documentation. Depending on the PNA model used, there may be 
a level shift of up to 10 dB. If a waveguide short is not connected the Test Receiver level 
will appear to have low amplitude.

d. If you are using more than one Transmission/Reflection module move the short to Port 2. 
If you are only testing one port proceed to step 6.

e. Compare the B,2 and R2, 2 traces to the data for your modules Test and Reference 
receivers for the millimeter-wave module on Port 2. The general level and shape should 
be similar.

f. Repeat step d and step e for Port 3 and compare trace 3 C,3 and R3, 3. 

g. Repeat step d and step e for Port 4 and compare trace 4 D,4 and R4, 4.
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Figure 1-29 Example; Banded Receiver Display 

5. Measure a Thru Connection. 

a. Connect the Port 1 to Port 2 module, and Port 3 to Port 4 module (N5262A) to form thru 
connections. 

b. Delete the trace 1, S11. Select Trace/Chan > Trace > Delete Trace.

c. Select [Preset] > Trace/Chan >Trace > New Trace. Select S12, S21, S34 and S43. This test 
confirms that the modules are sourcing and receiving. Refer to your millimeter-wave 
modules data from OML or VDI, included with the your module. 

NOTE S12 requires a Transmission/Reflection module on Port 1. 
S21 requires a Transmission/Reflection module on Port 2. 
S34 requires a Transmission/Reflection module on Port 3. 
S43 requires a Transmission/Reflection module on Port 4.

Figure 1-30 Uncalibrated S12 and S21 
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6. Measure the Dynamic Range of each Millimeter-wave module. 

a. Measure S11 for a 1-Port system, or S12 and S21 for a 2-Port system, or S12, S21, S34 
and S43 for a 4-Port system. 

b. Select [Avg] > IF Band wid th [10] > [Enter]. 

c. Set the power level to the maximum for each band.

d. For a 1-Port system connect a short to the test port. For a 2-Port or 4-Port system 
connect the module ports together to form thru connections. Refer to “Measure a Thru 
Connection.” on page 43 for connections.

e. Normalize each trace. Select the trace and press [Memory] > Normalize.

f. For a 1-Port system remove the TEST IF cable from the test set or module. For a 2-Port or 
4-Port system disconnect the module ports and connect a load or short to all module 
ports.

g. Select [Scale] > Reference Level > [-30] > [Enter]. Set the reference as needed to view each 
trace.

h. The S11, S12, S21, S34 or S43 traces show non-calibrated system dynamic range. The 
dynamic range will vary depending on the modules used, and the configuration of the 
system. Reference your modules document for performance information. See 
Figure 1-31.

i. Select [Memory] > Data Math > Off and review the traces for noise floor performance.

Figure 1-31 Dynamic Range Trace Example 
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System Level Troubleshooting
If the System Operation Verification procedure fails, perform the following procedure to isolate 
the problem. 

Refer to the Keysight PNA Series: firmware, Upgrades, and Support at:   
http://na.support.keysight.com/pna for further information. 

To request service, please contact your local service center. In the US, call 800-829-4444. For a 
listing of service centers worldwide, please visit us at http://www.keysight.com/find/service. 

1. Confirm that each piece of equipment is turned on, and all analyzer, and Module 
connections are correct.

2. Verify that the analyzer has the correct options for Millimeter mode operation. Refer to 
“Network Analyzer Requirements” on page 2.

3. Verify that the analyzer is in Millimeter mode for the waveguide band of the modules used. 

4. If the receiver levels (A,B, C, D or R 1) fail the Banded System check refer to the Measure, 
Test and Reference graphs in the documentation included with the module. If the REF IF and 
Test IF levels are low connect the REF IF and TEST IF cables directly from the mm-wave 
module to the analyzer’s rear panel IF Inputs. If the levels are correct proceed to step 7. If the 
levels are low continue with step 5.

5. If one of more of the ports are working, substitute the mm-module with a known working 
module. If the port is still not working measure the RF Out and LO Out power from the test 
set’s RF Out and LO Out connectors at the end of the cables. Replace or substitute the 
cables if the loss is greater than the cable specification. If the cables are not the cause 
proceed to step 7. 

CAUTION Turn off the test set before disconnecting or reconnecting the modules.

6. Confirm that the analyzer is working properly by disconnecting it from the test set and 
performing an Operation Verification (OP VER) in the Help menu. 

7. If the analyzer is operating properly, verify the test set by performing the “Test Set Operation 
Check” on page 46. If the test fails continue to “Test Set Troubleshooting” on page 59.

8. If the analyzer, test set and Modules are functioning, but the system is not operating 
properly, contact “Keysight Support, Services, and Assistance” on page 86.
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Test Set Operation Check 
This chapter contains service information for a standalone N5261A and N5262A controller test 
sets.

The following procedure verifies the test set without system components. 

The instructions below generally assume a 4-Port N5262A. If you are using a N5261A, omit 
Ports 3 and 4.

Preparation

Required Equipment 

• PNA, PNA-L, PNA-X capable of 20 GHz. (The required Test Set I/O interface is included with 
all models). The PNA, PNA-L or PNA-X will be referred to as the PNA throughout this 
procedure. 

• Two RF flexible cables with 3.5 mm male connectors (5062-6696 or equivalent). One cable 
must be long enough to comfortably connect between the PNA and the rear panel of the test 
set.

• Three SMA or 3.5 mm adapters (female to female)

• Voltmeter

• Power sensor and compatible power meter. The power sensor must be capable of measuring 
from -10 dBm to +15 dBm at a frequency of 8 GHz. A E4413A power sensor may be used.

Power Sensor and Power meter Preparation

The power sensor and power meter must be prepared to make measurements at 8 GHz. This 
may include calibrating the power sensor with the meter and entering a calibration factor for 
8 GHz.

PNA and Test Set Preparation

1. Connect the Test Set I/O cable from the PNA to the test set.

2. Turn on the PNA and the test set.

3. The PNA must be in “Standard PNA” mode.To check the mode, select Utility > System > 
Configure > Millimeter Module Configuration. The Millimeter Module Configuration window 
will be displayed. “Standard PNA” should be the Selected Configuration. If not, click on 
“Standard PNA” in the list of Available Configuration(s) then click OK.
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Test Set Operation Check
PNA Normalization Calibration

This procedure prepares the PNA to for path loss measurements.

1. Select [Preset] on PNA.

2. Set the Start and Stop frequencies.

3. Set the desired power output level.

4. Set to measure S12.

5. Connect an RF cable to PNA Port 1. Connect a second RF cable to PNA Port 2.

6.  Connect the two RF cables together with an adapter.

7. Normalize the trace, Select [Memory] > Normalize or select [Data] > Normalize. You will see a flat 
line at 0 dB.

8. Remove the adapter between the RF cables. 

Test Set I/O Commands 

The Test Set Operation Check requires the use of Test Set I/O commands. These commands are 
issued by the PNA.

Controlling the Test Set using Test Set I/O Commands

A Test Set I/O command may be used when the PNA is connected to the Test Set via the Test 
Set I/O cable. Commands may control the test set or read data from the test set. The GPIB 
command processor utility, in the network analyzer software, is used to communicate over the 
Test Set I/O connector.

It is recommended to use a USB keyboard with a PNA when using the command processor.

Using the GPIB command processor 

• Select Util ity > System > Configure > SICL/GPIB/SCPI, then GPIB Command Processor Console. In 
the dialog box type the command text and then Enter on the keyboard to execute the 
command. 

• A write command is of the form: cont:ext:test:data n,m   "n" is the address and "m" is the 
data to be written. Typically these values may be any number up to three digits in length.

• A read command is of the form: cont:ext:test:data? n    "n" is the address. A read command 
returns a single numeric value.

• Pressing F3 on the keyboard will recall a previously sent command line for editing. 

• As a check, send the command: cont:ext:test:data? 0   <enter>. A 61 or 62 should be 
returned, depending on the model number of the test set.

• An active command processor window may be minimized via the "_" in the upper right hand 
corner of the window. To access a minimized command processor window, minimize the PNA 
window. Select File > Minimize Application.
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Test Set I/O Command List

The following commands are available for controlling/reading the test set. The step-by-step 
commands in the Test Set Operation Check procedure require the use of these commands. The 
user is required to select the appropriate command, depending on the port or function under 
test.

Read commands involve a single number, an address. Write commands involve two numbers, 
address and data.


NOTE The amber Source LED’s are controlled separately from the switches for the 
RF OUT paths. 

The write commands for IF path control for the N5262A are listed in Table 2-2 on page 54. The 
commands for reading and writing gain factors for are listed in Table 2-5 on page 76.

Table 2-1 I/O Commands

0 address for reading two d igits from model number of the test set

32,0 turns on ALC for both SRC1 (Port 1 and 2) and SRC2 (Port 3 and 4)

32,1 turns off ALC for SRC1 (Port 1 and 2) 

32,2 turns off ALC for SRC2 (Port 3 and 4)

0,1 SRC1 IN to Port 1 RF OUT

0,2 SRC1 IN to Port 2 RF OUT 

0,16 SRC2 IN to Port 3 RF OUT

0,32 SRC2 IN to Port 4 RF OUT 

64,17 turns on Receiver and Source LED’s for Port 1 (all other LEDs off)

64,34 turns on Receiver and Source LED’s for Port 2 (all other LEDs off)

64,68 turns on Receiver and Source LED’s for Port 3 (all other LEDs off)

64,136 turns on Receiver and Source LED’s for Port 4 (all other LEDs off)
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Procedure

Verify DC Voltages and Front panel LED’s

Verify DC voltage levels on each of the front panel DC power connectors. 
Pins 1 & 3 = +12 V (± 0.8 V), Pins 4 & 6 = ground

Issue the Test Set I/O commands that apply to the Receiver and Source LED's for the test set 
model being tested. See the “Preparation” on page 46 for a list of possible commands. Confirm 
that each command drives the LED's appropriately.

1 3

6 4

2

5

7

n5260_001_304

Pin 1 (+12V)

Pin 6 (gnd)

Pin 3 (+12V)

Pin 4 (gnd)
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Measure LO OUT (Gain and Power)

Prepare the PNA to measure S12 with a normalization calibration. Refer to “PNA Normalization 
Calibration” on page 47. Use a frequency range of 8 to 20 GHz and a power level of -10 dBm. 
The cable on PNA Port 2 must be long enough to reach the rear panel of the test set. 

1. Connect the PNA Port 2 cable to the rear panel LO IN.

2. Connect PNA Port 1 to Port 1 LO OUT on the test set. Verify the LO Output gain is 
> 20 dB. The trace should be within 10 dB of “flat” and have no significant holes or 
discontinuities. Refer to Figure 2-1 on page 50.

3. Select [Sweep] > Sweep Type > CW Time. Set the sweep time to 5 seconds.

4. Select [Freq] > Start > [8 GHz].

5. Disconnect the cable from LO IN and measure the power at the end of the cable using a 
power sensor. The power should be in the -8 to -12 dBm range. Adjust the PNA power 
output level if needed.

Reconnect the cable to LO IN.

6. Measure the Port 1 LO OUT power using a power meter. The power should be +12 dBm 
(± 1.5 dB). Measure LO OUT for the other ports on the test set. 

Figure 2-1 LO Output Gain with -10 dB Input 
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Measure the SRC1 & SRC2 RF Paths

The following procedure verifies SRC1 and SRC2 internal cables between the front and rear 
panels.

Prepare the PNA to measure S12 with a normalization calibration using a frequency range of 
8 to 20 GHz and a power level of -8 dBm. See “PNA Normalization Calibration” on page 47. 
The cable on PNA Port 2 must be long enough to reach the rear panel of the test set. 

1. Remove the SRC1 RF IN to SRC1 RF OUT rear panel jumper.

2. Connect the PNA RF Port 1 to SRC1 RF IN on the front panel.

3. Connect Port 2 to the rear panel SRC1 RF OUT.

4. The maximum loss should be < 2.5 dB.

5. Repeat the steps above with appropriate modification to measure the SRC2 path, the 
maximum loss should be < 2.5 dB.

Measure RF OUT (Gain and Power)

The following procedure measures gain.

Prepare the PNA to measure S12 with a normalization calibration. Refer to “PNA Normalization 
Calibration” on page 47. Use a frequency range of 8 to 20 GHz and a power level of 2 dBm.

1. Re-install the SRC1 RF IN to SRC1 RF OUT and the SRC2 RF IN to SRC2 RF OUT rear panel 
jumpers.

2. Connect PNA Port 2 to SRC1 RF IN on the front panel.

3. Connect the PNA Port 1 to the Test Set Port 1 RF OUT.

4. Issue the Test Set I/O commands 32,0 and 0,1 (enable ALC and output to Port 1). Verify that 
the gain is greater than 10 dB at all frequencies and there are no holes or significant 
discontinuities in the trace. Refer to Figure 2-2 on page 52.

5. Issue the Test Set I/O command 32,1 (disable ALC on Port 1). Verify that the gain increases 
at all frequencies and that there are no holes in the trace. Refer to Figure 2-3 on page 52.

6. Repeat the previous the previous four steps for each of the remaining test set ports using 
appropriate SRC1/2 connections and appropriate Test Set I/O commands.

The following procedure measures the power output level.

1. Select [Sweep] > Sweep Type > CW Time. Set the sweep time to 5 seconds.

2. Select [Freq] > Start > [8 GHz]. 

3. Set the PNA power output level to 2 dBm.

4. Connect the PNA Port 2 to SRC1 RF IN.

5.  Issue the Test Set I/O commands 32,0 and 0,1 (enable ALC and output to Port 1). 

6. Measure the Port 1 RF OUT power using the power sensor. Confirm that RF OUT is 
+12.5 dBm (± 1.5 dB). 

7. Repeat the previous three steps for each of the remaining test set ports using appropriate 
SRC1/2 connections and Test Set I/O commands.
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Figure 2-2 RF Output Gain with +2 dBm ALC On

Figure 2-3 RF Output Gain with +2 dBm ALC Off
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Measuring Test IF and REF IF Path Loss on the N5261A

NOTE The IF paths for the N5261A are not switched, see Figure 2-8 on page 64.

The cable connected to PNA Port 1 must be long enough to reach the rear panel of the test set.

1. Prepare the PNA to measure S12 with a normalization calibration. Select a frequency range 
of 10 to 20 MHz and a power level of -20 dBm. See “PNA Normalization Calibration” on 
page 47.

2. Measure the signal paths listed below. Connect PNA Port 2 to the test set front panel. 
Maximum loss should be < 3 dB.

• Port 1 TEST IF to A (rear panel)

• Port 1 REF IF to C (rear panel)

• Port 2 TEST IF to B (rear panel)

• Port 2 REF IF to D (rear panel)

Measuring Test IF and REF IF Path Loss on the N5262A 

NOTE The IF paths for the N5262A are switched (i.e. multiplexed), see Figure 2-9 on 
page 65.

The cable connected to PNA Port 1 must be long enough to reach the rear panel of the test set.

1. Prepare the PNA to measure S12 with a normalization calibration. See “PNA Normalization 
Calibration” on page 47. Select a frequency range of 10 to 20 MHz and a power level of 
-20 dBm. See “PNA Normalization Calibration” on page 47.

2. Measure each path listed in Table 2-2 on page 54 for N5262A. Each path is defined by 
entries in the “From:” and “To: N5262” columns. 

- For a given IF path, issue the appropriate command then measure the gain (loss) and 
connect PNA Port 2 to the appropriate connection on the front panel of the test set.

- The maximum path loss is listed for each path. 

- There should be no holes or significant discontinuities on the traces. Figure 2-4,  Figure 2-5 
and Figure 2-6 on page 55 are examples of acceptable traces. 
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Table 2-2 IF Path Measurement 

From: TEST IF 
Front Panel

To: N5261A Rear 
Panel IF OUT

To: N5262A Rear 
Panel IF OUT Command1

1. Commands are not required for the N5261A.

Max Path Loss 
for N5262A (dB)

Port 1 TEST IF A A 16,8 3

Port 2 TEST IF B B 16,4 3

Port 3 TEST IF n/a C 16,2 3

Port 4 TEST IF n/a D 16,1 3

Port 1 REF IF C D 16,8 6.0

Port 1 REF IF n/a R 16,33 7.5

Port 2 REF IF D C 16,4 6.0

Port 2 REF IF n/a R 16,2 7.5

Port 3 REF IF n/a A 16,2 6.0

Port 3 REF IF n/a R 16,56 7.5

Port 4 REF IF n/a B 16,1 6.0

Port 4 REF IF n/a R 16,20 7.5
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Figure 2-4 Test IF Path to A, B, C or D

Figure 2-5 Ref IF to A, B, C or D 

Figure 2-6 Ref IF to R
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Theory of Operation 

Functional Block and Assembly Information

The N5261A/62A routes PNA-X LO and RF signals to a millimeter-wave module. This allows the 
PNA-X to up-convert for a millimeter-wave source and down-convert a received 
millimeter-wave frequency to an IF frequency 7.6 MHz. It also provides the DC power for the 
millimeter-wave module. The following components are used in the N5261/62A. Refer to the 
block diagrams, Figure 2-10 through Figure 2-13 beginning on page 66.

Test Set Control Board (N5261-60006)

The Test Set Control board (N5261-60006) is a surface mount, printed circuit assembly (PCA) 
that provides a connection to the power supply and the PNA-X Test Set I/O. The PNA-X sends 
address and data commands which are read by the test set controller for selecting the switch 
paths of the SRC1 and SRC2 RF and IF switch paths. The test set controller board has a 
programmed FPGA and memory (NovRam) with model number and gain correction values for 
the Amplifiers and ALC circuits. Switch S1 is set to lock the memory after calibration is been 
loaded. The front panel “Active” and port LEDs are only on when the PNA-X has addressed the 
N5261/62A Millimeter Head Controller. The rear panel fan is on when the Controller board 
supplies are operational. 

IF the Controller board is replaced, the gain data will need to be stored into the new board. 
Refer to “Contacting Keysight” on page 86 for the replacement procedure.

Interface Board (N5261-60101)

The Interface board is installed on top of the test set controller board. It provides switch drive 
signals and voltage for the solid-state switches that select RF Inputs (SRC1 or SRC2) to one of 
the front panel RF Outputs ports. It provides switching from the front panel TEST IF and REF IF 
Inputs to the rear panel IF Outputs D/R2 C/R1, R, A, B. The board also provides DC voltage, ALC 
control of the Amplifiers and a FPGA programmed device that enables N5261/62A Millimeter 
Head Controller operation.

LED Board (N5261-60005)

Two LED board assemblies are mounted to the front panel. The top LED board indicates the 
Source Path (amber/yellow color), or Receiver Path (green colored) shown as “S” and “R” for 
each port. The bottom LED Board indicates the DC Power is on (green). If an over-current 
condition occurs on the millimeter-wave module the LED will be (amber/yellow), which could 
be a result of a shorted interface cable or damaged Millimeter-wave module. The LED board 
assemblies are connected to the test set controller board by ribbon cables. 

DC Power Board (N5261-60102)

The DC Power board provides connection to the power supply and self recovering fuses for each 
millimeter-wave module supply (+12 volt) on the front panel. The fuses are reset when the 
N5261/62A is turned off. 
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Power Supply (0950-4729)

The power supply (0950-4729) coverts the AC line voltages to DC. This is an automatic line 
voltage selecting power supply. The AC line voltage (100 to 240 V @ 50/60 Hz) is provided from 
the line module located on the rear panel. 

Isolators (0955-1595)

Isolators are installed in the LO Output RF path for each port. These 10 watt isolators maximizes 
the LO power input to the millimeter-wave modules over a frequency range of 8 to 19 GHz.

LO Preamplifier (5087-7750)

A preamplifier installed in the LO Input path provides a higher RF power level required for the 
LO Amp. 

RF and LO ALC Amplifier (5087-7771)

The Mod/Amp has adjustable gain that provides ALC leveling for the front panel RF and LO 
Output signals. Adjustments are made on each Mod/Amp to set the maximum output power to 
+12.0 or +12.5 dBm (R3). The output of each amplifier is connected to a coupler, and with a 
detector for ALC, the mod/amps provide RF and LO leveling. Each Mod Amp has a Bias board 
(N5261-60103) installed on top that provides the power supply connection and circuitry for 
setting the gain of the amplifier (R3) and an SMB Input to the modulator.

The ALC function for the LO is always enabled. The ALC function for the RF sections may be 
turned off. The test set controller board stores open loop gain values for the RF sections. These 
gain values are used by the PNA firmware to provide a power level of approximately 10 dBm to 
the mm-wave heads when the ALC function is off.

Attenuator, 7 dB (0955-0242)

This attenuator is used at the LO Input port to provide a good match and set the LO Input level 
for the preamplifier. 

Attenuator, 6 dB (0955-0243)

The 6 dB attenuators are used to attenuate the RF and LO power to the ALC detector to set the 
RF level for linear operation. 

Attenuator, 3 dB (0955-0246)

The 3 dB attenuators are used in the SRC1 or SRC2 Mod/Amp Inputs to provide a good match 
and ensure it does not exceed +15 dBm. 

Coupler (0955-0148)

Directional couplers with 10 dB coupling factor are used for ALC feedback for RF and LO Output 
leveling.
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Slope Attenuator Cable Assy (N5262-20033)

A slope pad is installed on the leveling coupler of the RF Out path to compensate for the RF 
switch loss at higher frequencies.

Power Divider (N5262-80003)

A four-way power divider provides each Port LO Output from the LO amplifier with 
approximately 7.2 dB attenuation for each LO Out. Two 50 ohm terminators are installed on the 
unused N5261A divider paths. If a system is configured with a unused port (a 1-Port reflection 
system for example) the front panel LO Output ports are to be terminated with a 50 ohm load 
(1810-0118). This keeps the power divider balanced and prevents an “open” reflective signal 
from entering the power divider and mixing with the RF signal.

RF Switch (5087-7733)

A solid-state switch with internal 50 ohm termination is used for switching the RF Output path 
for Ports 1 and 2, or Ports 3 and 4. These switches are controlled by the test set controller and 
interface boards.
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Test Set Troubleshooting
For assistance refer to “Keysight Support, Services, and Assistance” on page 86.

If the test set is not operating properly, use the following procedures to aid in isolating the 
problem. Refer to the “Test Set Diagrams and Graphics” starting on page 64. 

Power Supply and Fans

1. Verify the front panel Standby switch is operational.

a. The rear panel fan and front panel DC Power LEDs should be on when the Standby switch 
is in the on position.

2. AC Line voltage checks.

a. Ensure the proper AC line voltage is present at the instrument line cord.

b. Remove the AC power cord from the instrument. Check the instrument AC line module 
5 amp fuse, as shown in Figure 1-9 on page 23.

c. Remove the instrument bottom cover. Near the rear panel are two fuse holders, remove 
the 8 amp fuses and verify that they are operational. See Figure 2-18 on page 73.

3. Internal DC Power checks. 

a. Set the Standby switch to the Standby position. 

b. Remove the top cover and connect the AC power cord. No fans or DC power LEDs should 
be on.

c. Set the Power Switch to the on position. Both rear panel and internal power supply fans 
should be operational; the front panel DC Power LEDs should be on. If the DC Power LEDs 
are off, measure the +12 Vdc pins on the front panel connectors. Refer to “Test Set I/O 
Commands” on page 47. 

d. Ensure the Controller board DC Supply indicator LEDs are on. If not, suspect power 
supply (0950-4727) or front panel Standby switch. Using a DVM measure the power 
supply terminal connections. Refer to the label on the power supply for voltages on the 
terminals screws. Figure 2-7 on page 60.

e. If the voltages on the power supply are correct, lift the Interface board. If the Controller 
board DC Supply LEDs are on, disconnect switches (J60 & J61) and amp cables (J10, 11, 
12 and 14) to the Interface board and re-install the board. If the indicator LEDs are on, 
suspect the switch or amplifier. Table 2-3 on page 60. 

f. If the fan is not working and all Controller board DC Supply LEDs are on, replace fan.
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Figure 2-7 DC Power Check Locater

Table 2-3 Interface Board DC Power Distribution Details 

Ref Des Load DC Voltage DC Source

J10 RF Amp1 2, -2, 9, 15, -15 Main PS U22 & U23

J11 RF Amp2 2, -2, 9, 15, -15 Main PS U22 & U23

J12 LO Pre Amp 15 Main PS

J14 LO Amp 2, -2, 9, 15, -15 Main PS U22 & U23

J60 RF Sw1 -10 & 13 U20 & U21

J61 RF Sw2 -10 & 13 U20 & U21

Interface Bd.

+5v

+24v

+3v

-15v

-12v

+15v

+12v

-10v

+9v

-10 Vdc

13 Vdc
probe the tab

Test Set Controller Bd.

= LED INDICATOR 
(DC Power)Instrument Rear Panel

U23
U22

U24

U21

Secondary DC 
Supply Test Points

U20

U25

U23U22

U24

U21U20

U25

5 Vdc

-5 Vdc

-2 Vdc

TP 
(GND)

TP1

Main DC Supply 
Indicators

Controller Status LEDs

2 Vdc
probe the tab
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No DC Power for Millimeter-wave Modules

1. Remove the top and bottom covers.

2. Inspect the DC Power board (N5261-60002) connections.

3. Measure the +12 Vdc (red wires) on the DC Power board. If the +12 Vdc is present, replace 
the DC power cable from the front panel (N5652-60001). If the +12 Vdc is not present go to 
step 4.

4. Verify that the supply LED indicators on the Test Set Control Board (N5261-60006) are on. If 
they are, replace the DC Power Board (N5261-60002). Refer to Figure 2-14 on page 70. If the 
LEDs not off, refer to “Test Set Troubleshooting” on page 59. 

Over Current LEDs are On (amber)

1. Remove all millimeter module connections from the front panel. If the over current LEDs are 
off, suspect the millimeter module or the DC Power Bias cable. If the LEDs are on continue 
with step 2.

2. Verify that the +12 Vdc on the front panel DC Power connectors is not shorted to ground. 
Refer to “Test Set Operation Check” on page 46. If it is shorted to ground, replace the front 
panel DC Power cable (N5652-60001) or the DC Power Board (N5261-60002). If it is not 
shorted to ground continue to step 3. 

3. Move the DC Power board ribbon cable to the Source/Receiver Status LED board, if the over 
current LEDs are still on replace the DC Power Board (N5261-60002). If the LED’s are off 
replace the DC Power LED Board (N5261-60005).

Front Panel Active and Port Status LED

Front Panel R and S Indicator LED check. If the LED indicators are not operating, verify the 
ribbon cable connection and ensure the rear panel test set interface cable is connected 
securely. Proceed to the next section for further troubleshooting before replacing the front 
panel board.

1. Connect the Test Set I/O cable (N4011-21002) from the analyzer to the test set.

2. Using the I/O command values, confirm the correct address and data values are used, refer 
to Table 2-2 on page 54.

3. Front Panel R and S indicator LED Check.

a. Verify that at least three of the Controller Status LEDs, are on. Refer to Figure 2-7 on 
page 60.

b. If none are on remove the Switch Driver board and recheck, if still no indication, replace 
the Controller board.

c. If the Controller Status LEDs and the front panel Active LED is on, suspect the front panel 
LED board or the ribbon cable. Replace as needed. You can move the ribbon cable 
connection to the DC power board and verify if the problem is the Port Status LED board, 
or use the ribbon cable from the DC power board to verify if the problem is the ribbon 
cable. 
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RF OUT Failures

If the test ports are not switching, or fail the Operational Check the following procedures can be 
used to verify the failure. The procedures assume power supplies, controller board and front 
panel LEDs are working. Suspect the switch Interface board, ribbon cable connection or RF 
switch. Refer to Table 2-3 on page 60 and Figure 2-7 on page 60.

1. Inspect the ribbon cable connections from the RF switches to the Switch Interface board 
(N5261-60001). Ensure the RF jumpers (E8356-20072) are installed on SRC1 IN/OUT and 
SRC2 IN/OUT on the rear panel. 

2. Start by measuring the power at SRC1 or SRC2, continuing through the RF Amp, Directional 
Coupler and Solid State Switch. If you find incorrect power levels and suspect a component 
has failed verify the DC voltages referencing Table 2-3 on page 60 and Figure 2-7 on 
page 60. Replace the failed component.

If you suspect the RF Amp (5086-7771) substitute the LO Amp (5086-7771) to verify the 
failure. The RF Amp uses a leveling circuit with directional coupler and detector that also can 
be checked before replacing the RF Amp. You may also substitute the Directional Coupler 
and Detector from the LO Amp section. If the RF Amp is replaced a gain calibration must be 
preformed. 

3. If you suspect the Solid State Switch (SW1 & SW2) confirm that one of its two LEDs toggle 
on/off when you send a Test Set I/O command. Refer to “Measure RF OUT (Gain and Power)” 
on page 51 and Table 2-2 on page 54.

4. Substitute a known good switch, or connect a known good wire-harness cable and retest. 
Replace if necessary. 

5. If the problem is not the switch measure the switch drive voltage on the Interface board (J60 
or J61, Pin 1) for a change in voltage (-10 V or +13.0 V), use I/O command in Table 2-2 on 
page 54. Replace the Interface board. 
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LO Out Failure

If the LO Out fails the Operation Verification test the following procedure can be used to verify 
the failure. The procedures assume power supplies, controller board and front panel LEDs are 
working. Suspect the switch Interface board, Bias cable, RF pre-amp or Power Divider. 

1. If one or more of the LO ports are working, suspect the Power Divider. 

2. If none of the port are working, start by measuring the power at LO IN, continuing through 
the pre-amplifier, LO Amp, Directional Coupler and Power Divider. If you find incorrect power 
levels and suspect a component has failed verify the DC voltages referencing Table 2-3 on 
page 60 and Figure 2-7 on page 60. Replace the failed component.

If you suspect the LO Amp (5086-7771) substitute the RF Amp (5086-7771) to verify the 
failure. The LO Amp uses a leveling circuit with directional coupler and detector that also 
can be checked before replacing the LO Amp. You may also substitute the Directional 
Coupler and Detector from the RF Amp section. 

REF IF or Test IF Failure

If the REF IF or Test IF fails the Operation Verification test the following procedure can be used 
to verify the failure. The procedures assume power supplies, controller board and front panel 
LEDs are working. Suspect the switch Interface board or coaxial cables. Refer to Table 2-3 on 
page 60 and Figure 2-7 on page 60.

1. N5261A - Verify that the front panel Port 1 & 2 REF and IF coax cables are properly 
connected to the rear panel (A, B, C and D) and insertion loss is not > -2.5 dB. Replace the 
coax cable if defective. Refer to Figure 2-8 on page 64.

2. N5262A - Verify that the front panel Port 1 & 4 REF and IF coax cables and rear panel coax 
cables (A, B, C, D and R) are properly connected to the Interface board. Verify that the 
insertion loss is not > -2.5 dB. Replace the coax cable if defective.

3. If the coax cables are properly connected and the insertion loss is correct, replace the 
Interface board. Refer to Figure 2-9 on page 65.
User’s and Service Guide N5262-90001  63



Service Information
Test Set Troubleshooting

2-
Test Set Diagrams and Graphics

Figure 2-8 N5261A Test Set Diagram
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Figure 2-9 N5262A Test Set Diagram
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Figure 2-10 N5261A RF and LO Block Diagram1 

1. Refer to Figure 2-8 on page 64 for IF paths.
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Figure 2-11 N5262A RF and LO Block Diagram1

1. Refer to Figure 2-9 on page 65 for IF paths.
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Figure 2-12 Signal Routing 2-Port

Figure 2-13 Signal Routing 4-Port
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Part Replacement and Location Information 
There are many other repair and calibration options available from the Keysight Technologies 
support organization. These options cover a range of service agreements with varying response 
times. Contact Keysight for additional information on available service agreements for this 
product.

Replaceable Parts 

Special options are built to order, so long lead times may be encountered when ordering 
replacement parts. For parts that are not listed in the following table refer to “Keysight Support, 
Services, and Assistance” on page 86.

Description
Keysight 
Part Number

Millimeter Head Interface Bd N5261-60101

DC Power Bd N5261-60102

RF/LO Bias/ALC Bd N5261-60103

Preamplifier Bias Bd N5261-60104

LED Bd, Front Panel N5261-60005

Test Set Controller Bd N5261-60006

RF 4-way Divider N5262-80003

RF Detector 33330-80021

Coax Cable, Sloped Attenuator N5262-20033

DC Power Supply 0950-4729

RF Isolator, 20 GHz 0955-1595

Preamplifier 5087-7750

RF/LO Amplifier 5087-7771

Coax Attenuator (3 dB) 0955-0246

Coax Attenuator (6 dB) 0955-0243

Coax Attenuator (7 dB) 0955-0242

RF Directional Coupler (2-20 GHz) 0955-0148

RF Switch, SPDT Solid State 5087-7733

Hex Nut 0140-0084

Lock Washer 2190-0067

Fuse 5 A/250V 2110-0709

Cable, IF MUX, front panel 8121-0150

Cable, IF MUX, rear panel 8120-8483
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Figure 2-14 N5261A Top View
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Figure 2-15 Slope Pad

Figure 2-16 N5261A Top Front View 

Isolator                 ALC Coupler Status LED Bd RF Switch Isolator   

DC Power
LED Bd

ALC 
 

 LO Power Amp            Port 1 & 2 ALC Amp

 

Detector
Coupler 

Slope Pad

LO ALC Amp
User’s and Service Guide N5262-90001  71



Service Information
Part Replacement and Location Information

2-
Figure 2-17 N5262A Top View1

1. Refer to Figure 2-9 on page 65 for IF cable routing between the Interface board and the front and rear 
panels.
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Figure 2-18 N5262A Bottom View
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2-
Test and Ad justment Procedures
The “Test Set Operation Check” on page 46 should be performed whenever any active 
electronic part is replaced in the test set. 

Additional procedures are required when certain components are replaced. Table 2-4 indicates 
when additional procedures are required. The additional procedures depend on the location of 
the replaced component.

The additional procedures are indicated as A, B, C, D, F, Q, R, S and Z in Table 2-4. 

The procedures referenced above may be found on the following pages. Many of the steps 
require familiarity with the “Preparation” section beginning on page 46.

Table 2-4 Additional Required Procedures for Assemblies Replaced

Description of the 
Replaced Component

Keysight 
Part Number

Location:
Ports 1 & 2 
RF Section1

1. Refer to Figure 2-9 thru Figure 2-12 and Figure 2-15 thru Figure 2-18 to determine part location. 

Location:
Ports 3 & 4 
RF Section1

Location: 
LO Section

General 
Location

Millimeter Head 
Interface Bd

N5261-60101 Z

Test Set Controller Bd N5261-60006 C2   D

2. Procedure “C” must be done before removing the “old” board. 

RF/LO Bias/ALC Bd N5261-60103 Q R S

Preamplifier Bias Bd N5261-60104 S

RF 4-way Divider N5262-80003 S

RF Detector 3333-80021 Q R S

Coax Cable, Sloped 
Attenuator

N5262-20033 Q R

Preamplifier 5087-7750 S

RF/LO Amplifier 5087-7771 Q   A   D R   B   D S

RF Directional Coupler 0955-0148 Q   A   D R   B   D S

RF Switch, SPDT Solid 
State

5087-7733 Q   A   D R   B   D
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Gain Factors for the SRC RF Paths

Background

The controller board in the test set stores gain factors for the various SRC RF paths in 
non-volatile memory. These gain factors are used by the PNA firmware to ensure that the SRC 
RF power delivered to the mm-wave head is approximately 11 dBm when the ALC is off.

When a component in a SRC RF path is replaced it is necessary to measure the new gain factors 
and update the values stored on the controller board. Typically the gain factors must be 
updated whenever one or more of the components in an “RF Section” of Figure 2-10, “N5261A 
RF and LO Block Diagram,” or Figure 2-11, “N5262A RF and LO Block Diagram.” is replaced.

When a controller board is going to be replaced, if possible, the gain factors should be read 
from the old controller board before it is removed from the test set. After the new controller 
board is installed the gain factors must be written into the test set. If the gain factors cannot be 
read from the old board then the gain factors must be measured after the new controller board 
is installed.

Instructions for issuing Test Set I/O commands are contained in the “Preparation” section 
beginning on page 46. Table 2-4 on page 74 indicates which procedure(s) is required.

Measure Gain Factors for Ports 1 and 2 (Procedure A)

1. Connect the SRC 1 jumper on the rear panel of the test set.

2. [Preset] the PNA. Set the measured frequency range from 7 GHz to 20 GHz.

3. Set the PNA power output level to -15 dBm. Set the PNA to measure S12.

4. Connect cables to PNA Ports 1 and 2. These two cables will allow connection to the front 
panel of the test set.

5. Connect the two cables together using an adapter and perform a normalization calibration. 
Refer to “Test Set Operation Check” on page 46 for instructions.

6. Connect PNA Port 2 to SCR1 IN and PNA Port 1 to Test Set Port 1 RF OUT.

Issue the Test Set I/O commands 32,1 and 0,1 (turn off SRC1 ALC and set path to Port 1).

7. Set markers for 7, 10, 15 and 20 GHz on the PNA trace.

8. Read the value for each marker and translate to tenths of a dB (round the raw number as 
required). Example: a reading of 25.34 dB would be translated to a value of 253.

9. Record the values for Port 1 in Table 2-5 on page 76.

10. Issue the Test Set I/O command 0,2 to set the path to Port 2.

11.Move the PNA Port 1 cable to Test Set Port 2 RF OUT.

12.Record the values for Port 2 in Table 2-5.
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Measure Gain Factors for Ports 3 and 4 (Procedure B)

Repeat the process above for Ports 3 and 4 with the following modifications:

• Connect the SRC2 jumper on the rear panel.

• Connect to SRC2 IN in place of SRC1 IN.

• The first set of Test Set I/O commands should be 32,2 and 0,16.
(turn off SRC2 ALC and set the path to Port 3)

• The Test Set I/O command to set the path to Port 4 is 0,32.

Table 2-5 Gain Factor Addresses and Values

Ports/Freq
Write 
Address

Read 
Address

Value

Port 1 - 7 GHz 144 16

Port 1 - 10 GHz 148 20

Port 1 - 15 GHz 152 24

Port 1 - 20 GHz 156 28

Port 2 - 7 GHz 160 32

Port 2 - 10 GHz 164 36

Port 2 - 15 GHz 168 40

Port 2 - 20 GHz 172 44

Port 3 - 7 GHz 176 48

Port 3 - 10 GHz 180 52

Port 3 - 15 GHz 184 56

Port 3 - 20 GHz 188 60

Port 4 - 7 GHz 192 64

Port 4 - 10 GHz 196 68

Port 4 - 15 GHz 200 72

Port 4 - 20 GHz 204 76
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Test and Ad justment Procedures
Read Gain Factors from the Test Set (Procedure C)

Issue a separate Test Set I/O read command for each entry in Table 2-5 on page 76. Record 
each value as it is read from the test set. As an example, to read the value for Port 2 at 10 GHz, 
issue the following command: 36. The command will return the value stored in the test set. The 
value is an integer representing tenths of a dB. Ignore the leading “+”.

Write Gain Factors to the Test Set (Procedure D)

A slide switch must be accessed to enable writing of gain factors. The switch is located on the 
test set Control Board next to U5, close to the rear panel. (The test set control board is shown in 
Figure 2-17 on page 72) “NWE” and “NCLR” labels are silk-screened near the sides of the 
switch. To enable writing, slide both sections of the switch toward U5. To disable writing, slide 
both sections of the switch away from U5. The switch may be covered with soft, transparent 
plastic. A sharp, stiff tool may be required to manipulate the switch.

Enable writing via the slide switch.

Issue a separate Test Set I/O write command for each entry in Table 2-5. As an example, to 
write a value of “253” for Port 1 at 7 GHz, issue the following command: 144,253.

It is only necessary to write “new” values. If only Procedure A has been performed and not 
Procedure B, then only values for Ports 1 and 2 need to be written. If a test set controller board 
has been replaced, then values for all four ports must be written for an N5262A.

Disable writing via the slide switch when this procedure is complete.
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Adjust ALC Levels

Background

When a component is changed in an RF or LO signal path, it is often necessary to adjust the ALC 
level for the path. See Table 2-4 on page 74 for required adjustments when a part is replaced.

PNA and Power Sensor Preparation

A power sensor and power meter must be prepared to make measurements at 8 GHz. This may 
include calibrating the power sensor with the meter and entering a calibration factor for 8 GHz.

1. Set the PNA to measure S12. 

2. Set for CW sweep at 8 GHz. 

3. Set the sweep time to 5 seconds. 

4. Set the power to -8 dBm. 

ALC level for Port 1 (Procedure Q)

1. Prepare the PNA and Power Sensor as described above. 

2. Connect PNA Port 2 to SRC 1 IN. 

3. Connect the power sensor to Port 1 RF OUT.

4. Issue the Test Set I/O commands: 32,0 and 0,1 (ALC on and Port 1 RF OUT).

5. Identify the “Port 1 & 2 ALC Amp”, see Figure 2-17 on page 72. Identity R7 and R3, see Figure 
2-19 on page 79.

6. Adjust R7: turn full CW (may require up to 30 turns) then 5 turns CCW.

7. Adjust R3: adjust for a reading on the power meter of 12.5 dB (± 0.1 dBm).

ALC level for Port 3 (Procedure R)

1. Prepare the PNA and Power Sensor as described above. 

2. Connect PNA Port 2 to SRC 2 IN. 

3. Connect the power sensor to Port 3 RF OUT.

4. Issue the Test Set I/O commands: 32,0 and 0,16 (ALC on and Port 3 RF OUT).

5. Identify the “Port 3 & 4 ALC Amp,” R7 and R3, see Figure 2-17 and Figure 2-19.

6. Adjust R7: turn full CW (may require up to 30 turns) then 5 turns CCW.

7. Adjust R3: adjust for a reading on the power meter of 12.5 dB (± 0.1 dBm).
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Test and Ad justment Procedures
ALC level for LO (Procedure S)

1. Prepare the PNA and Power Sensor as described on page 78. 

2. Connect PNA Port 2 to LO IN on the rear panel of the test set. 

3. Connect the power sensor to Port 1 LO OUT.

4. Identify the “LO ALC Amp,” R7 and R3, see Figure 2-17 and Figure 2-19.

5. Adjust R7: turn full CW (may require up to 30 turns) then 5 turns CCW.

6. Adjust R3: adjust for a reading on the power meter of 12 dB (± 0.1 dBm).

Figure 2-19 Mod Amp Identifiers

MUX RF Connections (Procedure Z)

Refer to Figure 2-9 on page 65 and Figure 2-17 on page 72 for the location of the Interface 
Board, SMB connectors and IF cable routing information. 

The SMB connectors on the cables that connect to the Interface Board (N5261-60101) 
sometimes become loose after multiple connections. A loose connector may allow crosstalk 
between IF signals and may cause higher than expected noise floors. After installing an 
Interface Board, check for loose connectors on all thirteen SMB connectors (J303, J250, J302, 
J200, J301, J150, J300, J100, J251, J201, J151, J101, J304). 

If there is a loose connection, replace the cable. The N5262A front panel cables part number are 
8121-0150, rear panel cables are part number 8120-8483.

R3  R7
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Safety and Information 

Introduction

Review this product and related documentation to familiarize yourself with safety markings and 
instructions before you operate the instrument. 

This product has been designed and tested in accordance with accepted industry standards, 
and has been supplied in a safe condition. The documentation contains information and 
warnings that must be followed by the user to ensure safe operation and to maintain the 
product in a safe condition.

Safety Earth Ground

WARNING This is a Safety Class I Product (provided with a protective earthing ground 
incorporated in the power cord). The mains plug shall only be inserted in a 
socket outlet provided with a protective earth contact. Any interruption of the 
protective conductor inside or outside of the product is likely to make the 
product dangerous. Intentional interruption is prohibited.

CAUTION Always use the three prong AC power cord supplied with this product. Failure to 
ensure adequate earth grounding by not using this cord may cause product 
damage and the risk of electrical shock.

Declaration of Conformity

Declarations of Conformity for this product and for other Keysight products may be downloaded 
from the Keysight Regulatory Website. Click on "Declarations of Conformity" and enter your 
product number to find the latest Declaration of Conformity statement. 
http://regulations.about.keysight.com

Statement of Compliance

This instrument has been designed and tested in accordance with CAN/CSA 22.2 No. 
61010-1-04, UL Std No. 61010-1 (2nd Edition).
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Safety and Information
Before Applying Power

Verify that the premises electrical supply is within the range of the instrument. The instrument 
has an autoranging power supply.

WARNING If this product is not used as specified, the protection provided by the equipment 
could be impaired. This product must be used in a normal condition (in which all 
means for protection are intact) only.

CAUTION The Mains wiring and connectors shall be compatible with the connector used in 
the premise electrical system. Failure, to ensure adequate earth grounding by not 
using the correct components may cause product damage, and serious injury.

CAUTION Always use the three prong AC power cord supplied with this product. Failure to 
ensure adequate earth grounding by not using this cord may cause product 
damage and the risk of electrical shock.

CAUTION This product is designed for use in Installation Category II and Pollution Degree.

CAUTION Before switching on this instrument, make sure the supply voltage is in the 
specified range.

CAUTION Verify that the premise electrical voltage supply is within the range specified on 
the instrument.

CAUTION Ventilation Requirements: When installing the instrument in a cabinet, the 
convection into and out of the instrument must not be restricted. The ambient 
temperature (outside the cabinet) must be less than the maximum operating 
temperature of the instrument by 4 °C for every 100 watts dissipated in the 
cabinet. If the total power dissipated in the cabinet is greater than 800 watts, 
forced convection must be used.
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WARNING Danger of explosion if battery is incorrectly replaced. Replace only with the 
same or equivalent type recommended. Discard used batteries accord ing to 
manufacturer’s instructions.

WARNING For continued protection against fire hazard replace line fuse only with same 
type and rating. The use of other fuses or material is prohibited.

WARNING These servicing instructions are for use by qualified personnel only. To avoid 
electrical shock, do not perform any servicing unless you are qualified to do so.

WARNING The opening of covers or removal of parts is likely to expose the user to 
dangerous voltages. Disconnect the instrument from all voltage sources before 
opening.

WARNING No operator serviceable parts inside. Refer servicing to qualified personnel. To 
prevent electrical shock, do not remove covers.

WARNING The detachable power cord is the instrument d isconnecting device. It 
d isconnects the mains circuits from the mains supply before other parts of the 
instrument. The front panel switch is only a standby switch and is not a LINE 
switch (d isconnecting device).

Connector Care and Cleaning Precautions

Remove the power cord to the instrument. To clean the connectors use alcohol in a well 
ventilated area. Allow all residual alcohol moisture to evaporate, and fumes to dissipate prior to 
energizing the instrument. 

WARNING To prevent electrical shock, d isconnect the Keysight N5261A or N5262A from 
mains electrical supply before cleaning. Use a dry cloth or one slightly 
dampened with water to clean the external case parts. Do not attempt to clean 
internally.

WARNING If flammable cleaning materials are used, the material shall not be stored, or left 
open in the area of the equipment. Adequate ventilation shall be assured to 
prevent the combustion of fumes, or vapors.
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Regulatory Information
Regulatory Information
This section contains information that is required by various government regulatory agencies.

Instrument Markings
The instruction documentation symbol. The product is marked with this symbol when it is 
necessary for the user to refer to the instructions in the documentation.

The AC symbol indicates the required nature of the line module input power.

This symbol indicates separate collection for electrical and electronic equipment, mandated 
under EU law as of August 13, 2005. All electric and electronic equipment are required to be 
separated from normal waste for disposal (Reference WEEE Directive, 2002/96/EC).   

This symbol indicates that the power line switch is ON.

This symbol indicates that the power line switch is in the STANDBY position.

This symbol indicates that the power line switch is in the OFF position.

This symbol is used to identify a terminal which is internally connected to the product frame 
or chassis.

The CE mark is a registered trademark of the European Community. (If accompanied by a 
year, it is when the design was proven.)

The CSA mark is a registered trademark of the CSA International. 

This mark designates the product is an Industrial Scientific and Medical Group 1 Class A 
product (reference CISPR 11, Clause 5)

This is a marking to indicate product compliance with the Canadian Interference-Causing 
Equipment Standard (ICES-001).

Direct Current.

IP 2 0
The instrument has been designed to meet the requirements of IP 2 0 for egress and 
operational environment.

The RCM mark is a registered trademark of the Australian Communications and Media 
Authority

Indicates the time period during which no hazardous or toxic substance elements are 
expected to leak or deteriorate during normal use. Forty years is the expected useful life of 
the product. 

This symbol on all primary and secondary packaging indicates compliance to China 
standard GB 18455-2001.

 South Korean Certification (KC) mark; includes the marking's identifier code which follows 
the format: MSIP-REM-YYY-ZZZZZZZZZZZZZZ.

ICES/NMB-001 
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Battery Collection

Do not throw batteries away but collect as small chemical waste, or in accordance with your 
country’s requirements. You may return the battery to Keysight Technologies for disposal. Refer 
to “Contacting Keysight” on page 86 for assistance.

Electrical Safety Compliance

SAFETY

Complies with European Low Voltage Directive 2014/35/EU

• IEC/EN 61010-1:2010, 3rd Edition 

• Canada: CSA C22.2 No. 61010-1-12

• USA: UL std no. 61010-1, 3rd Edition 

• Acoustic statement (European Machinery Directive 2022/42/EC, 1.7.4.2U)
Accoustical noise emission
LpA<70 dB 
Operator position
Normal operation mode
Per ISO 7779

EMI and EMC Compliance

EMC

Complies with European EMC Directive 2014/30/EU

• IIEC 61326-1:2012/EN 61326-1:2013

• CISPR Pub 11 Group 1, class A

• AS/NZS CISPR 11:2011

• ICES/NMB-001
This ISM device complies with Canadian ICES-001.
Cet appareil ISM est conforme a la norme NMB du Canada.

• South Korean Class A EMC declaration: This equipment is Class A suitable for professional 
use and is for use in electromagnetic environments outside of the home.

A 급 기기 ( 업무용 방송통신기자재 )이 기기는 업무용 (A 급 ) 전자파적합기기로서 판 매자 또는 사

용자는 이 점을 주 의하시기 바라 며 , 가정외의 지역에서 사용하는 것을 목적으 로 합니다 .
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Electrostatic Discharge Protection
Electrostatic Discharge Protection
Electrostatic discharge (ESD) can damage or destroy electronic components. The product is 
shipped in materials that prevent damage from static, and should only be removed from the 
packaging in an anti-static area ensuring that the correct anti-static precautions are taken. 

Two types of ESD protection are listed below. Purchase acceptable ESD accessories from your 
local supplier.

• Conductive table-mat and wrist-strap combination

• Conductive floor-mat and heal-strap combination

Both types, when used together, provide a significant level of ESD protection. To ensure user 
safety, static-safe accessories must provide at least 1 M of isolation from ground. 

WARNING These techniques for a static-safe work station should not be used when 
working on circuitry with a voltage potential greater than 500 volts.
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Keysight Support, Services, and Assistance

Service and Support Options

There are many other repair and calibration options available from the Keysight Technologies 
support organization. These options cover a range of service agreements with varying response 
times. Contact Keysight for additional information on available service agreements for this 
product. 

Contacting Keysight

Assistance with test and measurement needs, and information on finding a local Keysight office 
are available on the Internet at:
http://www.keysight.com/find/assist

You can also purchase accessories or documentation items on the Internet at: 
http://www.keysight.com/find

If you do not have access to the Internet, contact your field engineer.

NOTE In any correspondence or telephone conversation, refer to the Keysight 
product by its model number and full serial number. With this information, the 
Keysight representative can determine the warranty status of your unit.

Shipping Your Product to Keysight for Service or Repair

IMPORTANT Keysight Technologies reserves the right to reformat or replace the internal 
hard disk drive in your analyzer as part of its repair. This will erase all user 
information stored on the hard disk. It is imperative, therefore, that you make a 
backup copy of your critical test data located on the analyzer’s hard disk 
before shipping it to Keysight for repair.

If you wish to send your instrument to Keysight Technologies for service or repair:

• Include a complete description of the service requested or of the failure and a description of 
any failed test and any error message.

• Remove and retain the front handles and all rack mount hardware. The analyzer should be 
sent to Keysight in the same configuration as it was originally shipped.

• Remove and retain the front handles and all rack mount hardware. The analyzer should be 
sent to Keysight in the same configuration as it was originally shipped.

• Contact Keysight for instructions on where to ship your analyzer.
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